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1Touchpad CA-165-IX (Answer Key)

 Basics of Information Technology

I.	 a)	 Douglas Engelbert	 b)	 9	 c)	 120 mm
	 d)	 ALU, CU, MU	 e)	 Magnetic

II.	 a)	 (i)	 b)	 (iv)	 c)	 (i)	 d)	 (iii)	
	 e)	 (ii)	 f)	 (i)

III.	 a)	� Mobile Application: A mobile application, most commonly referred to as an app, is a type 
of application software designed to run on a mobile device, such as a smartphone or a 
tablet computer. Apps are generally small, individual software units with limited function.

	 b)	� Kernel: Kernel is the core part of an operating system that does all major activities (such 
as memory allocation, CPU time, scheduling, etc.) of the operating system. Kernel helps 
in initialization (booting) functions, like checking memory. It allocates and de-allocates 
memory space which allows the software to run.

	 c)	� File System: File system helps to organize and obtain grouped information or execution 
from a data storage device in a systematic manner. It is the basic structure to arrange a set 
of information with their names.

	 	 Different categories of file systems are:
	 	 FAT (File Allocation Table): Used in Pen drive, Flash Drive, 9X series of Windows.
	 	 NTFS (New Technology File System): Used in Microsoft Windows OS.
	 	 EXT (Extended File System): Used in Linux OS.
	 d)	� Device Driver: A device driver is a software that enables a hardware device to be compatible 

with the computer. It activates the specific hardware device that can be easily interpreted 
by the CPU resources. It is a program that automatically activates the hardware device that 
is attached to the computer.
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	 e)	� Cloud Computing: Cloud computing refers to the usage of IT application that are available 
on Cyber but stored in a remote server. Instead of keeping the files on a hard drive or local 
storage device, cloud based storage makes it possible to save a program or data on a remote 
storage media and can be accessed anywhere from the internet. It helps oganizations to 
use the same software at different locations at the same time thereby saving the cost of 
multiple installations. It also keeps the data safe.

	 f)	� Protocol: A protocol is a convention or a standard that regulates the operation and transfer 
of data between two computers. It can be defined as the set of rules governing the syntax, 
semantics, and synchronization of communication. Protocols may be applied by hardware, 
software, or a combination of the two.

	 g)	� Chat Sites: It is a feature of the Internet that enables instant message transmission from 
the sender to the receiver. The chat application enables transfer of text chat, audio chat, 
video calling, sharing desktops, etc. It helps in personal as well as commercial use. It takes 
place in real time if the receiver is online. The message can be sent to one or more persons 
at a time and the history is recorded. For chatting one must have an account. Example of 
such chatting applications are Google Hangout, Yahoo! Messenger, Whatsapp, Skype, etc.

	 h)	 �Social Network: Society is a community of people who are linked to each other on some 
common platform. Being social with hundreds of people over the internet is called social 
networking. In the field of computers, social networking refers to the link of hundreds of 
people around the world on the internet. It is the network of different people who form 
communities amongst themselves to share sentiments, relationships, topics, ideas, etc. On a 
social networking site a user creates his own profile by uploading information about himself. 
It can be a possibility that two people in a network may not know each other personally 
but are connected to each other on the basis of their uploaded profile.

IV.	 a)	� BIOS are predefined instructions that are stored in the ROM and start their operation as 
soon as the computer is switched ON. It is a set of essential softwares that tests the setup 
of hardware devices during startup. It helps to start the OS and supports the transfer of 
data among the hardware devices.

	 b)	 The wireless network technologies used these days are:
	 	 •	 Bluetooth
	 	 •	 Wi-Fi (Wireless Fidelity)
	 	 •	 Infrared
	 c)	� No, a computer can’t make decisions on its own because it can neither think nor work on 

its own. It works on the predefined instructions that are fed into it in the form of software 
programs.

	 d)	� RAM is said to have volatile memory because the instructions that are stored in it get erased 
away as soon as the power is switched OFF.

	 e)	� The processing speed of the microprocessor is much faster than the speed of data supply of 
the RAM. To compensate for the difference of speed the cache memory helps the RAM to 
carry data to the processor. In this way it enhances the processing speed of the computer.

	 f)	 A computer system can be prevented from a virus by the following ways:
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	 	 •	 �Download information from trusted websites. The web address of such websites starts 
with ‘https’. Untrusted websites might infect the computer system with a virus.

	 	 •	 �Installation of an antivirus. It acts as a safeguard and protects the computer from virus 
and for cleaning away unwanted programs. Antivirus programs are remedial software 
that scan, detect, clean, and remove virus from a computer system.

	 	 •	 Scanning and cleaning of hard disk.
V.	 a)	 The functional elements of a CPU can be divided into three parts:
	 	 •	 �Arithmetic Logic Unit (ALU): It performs mathematical calculations (addition, subtraction, 

division, multiplication) and logical camparisons (greater than (>). Less than (<), equal 
to (=), not equal to (!=)). Logical operation refers to comparison and sets the sequence 
of operations.

	 	 •	 �Control Unit (CU): It co-ordinates and directs the operation of the hardware devices. It 
also coordinates the flow and execution of data and instructions, that are fed into the 
computer’s memory. It fetches the data from the memory unit, decodes it, and passes it 
to the ALU for processing to execute and perform the required operations on the data.

	 	 •	 �Memory Unit (MU): It stores the data, instructions, intermediate results, and final results 
that are ready for output. The input data and instruction is also stored in the memory 
unit before being used by the ALU or CU.

	 b)	� Sets of pre-defined instructions written in computer language are known as programs. A 
set of organized programs that is made to perform a specific task/purpose is known as 
software. Software are classified as:

	 	 (i)	� Application Software: It is made to fulfill the specific need of the user. It is divided into 
two categories:

	 	 	 •	 �Application Packages: It is designed to accomplish some specific tasks which meet 
the needs of the general user. Some examples of application packages are:

	 			   Word Processing Package: MS-Word, OpenOffice Writer, Hangul, etc.
	 			   Spreadsheet Package: MS-Excel, OpenOffice Calc, Google Sheet, etc.
	 	 	 •	 �Customised Packages: It is designed to fulfill the specific requirement of a particular 

individual or an organization. It is also called ‘Tailor Made software’. Eg, Inventory 
management system, Fee collection system, etc.

	 	 (ii)	� System Software: It is designed to help the user to operate the computer system and 
utilize its resources. It acts as an interface or bridge between the user and the computer 
system. It is classified as:

	 	 	 •	 �Operating System: It is a system software that acts as an interface between the 
hardware and the user. It manages and co-ordinates the operation and the sharing 
of resources of the computer.

	 	 	 •	 �Language Processor: It is a type of system software that helps to convert programs 
in high level language to machine-understandable language.

	 	 (iii) �System Utility Software: It is a set of small programs that support the execution and 
operation of the computer system by doing additional work like scanning the hard disk, 
virus scanning, etc.
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	 c)	� The term networking of computers means a link of two or more computers which are 
connected together to share information and resources amongst each other. With the help 
of a computer network data can be transferred from one corner of the world to another 
instantly.

	 	 The advantages of networking are:
	 	 •	 �Sharing of files: Networking enables a user to share files among different nodes or 

workstations instantly.
	 	 •	 Sharing of resources: Networking enables a user to share hardware devices.
	 	 •	 Fast delivery of information: Networking enables a user to deliver information instantly.
	 	 •	 �Low cost of data transfer: Network reduces the cost of data or information transfer to a 

great extent.
	 d)	 The characteristics of a computer are as follows:
	 	 •	 �Speed: A computer works at a very high speed. It executes millions of instructions in a 

second.
	 	 •	 �Accuracy: It performs the tasks accurately. Calculations can be performed without mistakes.
	 	 •	 �Reliability: It does not fail to produce results as per the instructions given to it. It can 

perform tasks in places where human beings can’t work.
	 	 •	 �Versatility: A computer can work on various types of works with same accuracy and 

efficiency.
	 	 •	 Storage Capacity: It can store a large volume of data in a very small space.
	 	 •	 �Diligence: Unlike human beings, a computer does not suffer from problems such as 

tiredness, monotony, or lack of concentration and so can perform long hours of work 
without committing errors.

	 e)	 The common types of media used in guided networking are:
	 	 •	 �Ethernet Cable: Ethernet is a data link technology used in local area networks. This cable 

enables transmission speeds of 100:1000 Mbps, depending upon the quality of the cable. 
Computer devices such as keyboard, mouse, CPU, modem, etc. can also be connected 
through the Ethernet cable.

	 	 •	 �Co-axial Cable: A co-axial cable works as an efficient electrical transmission media. It 
consists of a single line of conductor surrounded by an insulation layer and a conductive 
shield over it. These cables enable transmission speeds of 100 Mbps and can maintain a 
bandwidth upto 400 Mhz. These cables are commonly used by cable operators in LAN.

	 f)	 The components of multimedia are:
	 	 •	 Text: It refers to typed content that can be read.
	 	 •	 Audio: It includes speech, audio effects, ambient sound, and music.
	 	 •	 Graphics: It includes drawings, paintings, scanned images, photographs, and video.
	 	 •	 Animation: It refers to the display of images in sequence or in a whirling motion.
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VI	 a)	 Impact Printer Non-Impact Printer
(i) It prints by striking the printer head 

or needle on an ink ribbon which 
rolls through the cartridge to make 
marks on the paper.

(i) �Non-Impact printer prints the output 
by thermal, chemical, electrostatic, 
laser beam, or inkjet technology.

(ii) An impact printer has less resolution 
and is slower as compared to a non-
impact printer.

(ii) �A non-impact printer has greater 
resolution and is faster as compared 
to an impact printer.

(iii) Eg.- Line Printer, Character Printer, 
Dot Matrix Printer.

(iii) Eg.- Inkjet Printer, Laser Printer.

	 b)	
Bluetooth Wi-Fi

(i) It is a type of wireless network 
connectivity that enables a user to 
connect or transfer data between 
devices over a small radius like 
mobile phones, laptop, personal 
computers, printers, etc.

(i) Wi-Fi is a network of wireless 
connection which has a larger range 
than bluetooth. It gives stronger 
connectivity than bluetooth. It is used 
to establish connections in video 
game consoles, home networks, 
PDA’s, tablets, mobile phones, etc.

(ii) The connectivity takes place based 
on radio wave technology. The 
range of communication is upto 
100 metres.

(ii) It is also used to connect the 
computers in a small campus of a 
school, office or organization within 
a distance of 150 metres.

VII.	 a)	 New Technology File System	 b)	 Light-emitting diode
	 c)	 Magnetic Ink Character Reader	 d)	 Power On Self Test
	 e)	 Computer Aided Design	 f)		 Desktop Publishing
	 g)	 Extended File System	 h)	 File Allocation Table
	 i)	 Wireless Fidelity	 j)		 Worldwide Interoperability for Microwave Access
	 k)	 Radio frequency
VIII.	
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	Cyber Safety

I.	 a)	 Internet	 b)	 Antivirus, Anti-spyware	 c)	 Cookies 

	 d)	 Password	 e)	 Privcay	 f)	 CERT-In	

	 g)	 Spammer	 h)	 Booting	 i)	 Keylogger

II.	 a)	 (i)	 b)	 (iii)	 c)	 (iv)	 d)	 (i)

	 e)	 (ii)	 f)	 (i)	 g)	 (iv)	 h)	 (i)

III.	 a)	� Indian Computer Emergency Response Team
	 b)	� Law Enforcement Agency
	 c)	 Master Boot Record
	 d)	 Blue Screen of Death
IV.	 a)	� Cybercrime: In this world of internet usage our personal data may remain insecure and 

sometimes prone to be misused. The tampering, stealing, manipulation of information, and 
unauthorized use of data or instructions by using the resources of the internet that may 
cause loss and other problems in someone’s life is called cybercrime.

	 b)	� Cyber Safety: Cybercrime has become very common in this cyber world. To safeguard 
from cybercrime some safety measures are taken to keep our personal information or data 
intact and secure from unauthorized access. These safeguarding measures are termed cyber 
safety.

	 c)	 �Identity Protection: This is a practice through which we can prevent our personal 
information like personal profile, bank account details, address details, family details, etc. 
from getting stolen.

	 d)	� Secure Transaction: Secure transaction is a system that ensures the security and integrity 
of electronic transactions made with credit cards.

	 e)	� Cookies: While visiting different websites certain files get temporarily downloaded into 
our local computer which are called cookies. The cookies are meant to store information 
related to activities performed during previous browsing sessions such as login details, 
visited pages of websites, etc., which can be tracked and misused by unauthorized users. 
Therefore, after completing the work, a user must refresh the operation before leaving the 
computer for another user.

	 f)	� Password: It is a combination of various character codes that are used to protect valuable 
content (documents, files, etc.) from unauthorized access. It also helps to keep our 
belongings or documents secure or secret. They can only be accessed when the user enters 

2.
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the secret character code correctly. It is similar to a key. Unless the correct key is used a 
lock doesn’t open. A password is a combination of letters, numbers, and special characters 
which is very difficult to guess.

V.	 a)	 The various measures to reduce cyber-attack are as follows:
	 	 •	 Identity Protection
	 	 •	 Protection of Username and Password
	 	 •	 Do not share Personal Information
	 	 •	 Make Online Transactions Secure
	 	 •	 Avoid use of Unsecured Wi-Fi
	 	 •	 Don’t Accept Invitations from unknown sources
	 	 •	 Use Antivirus and Anti-spyware
	 	 •	 Clear Browser cookies frequently
	 	 •	 Install Firewall
	 	 •	 Secure Password
	 b)	� Firewall is either a software or a hardware that helps to keep a network secure. It analyzes 

the network traffic and determines whether the traffic should be allowed or not in the 
network. It provides an additional layer of security to the computer.

	 c)	� It is the crime of using the internet, e-mail, or other types of electronic communications to 
harass or threaten other people. It includes sending absurd and nasty text messages, vulgar 
videos and obscene pictures on social media or e-mails. It also includes faking someone 
else’s profile or making a fake profile with wrong intentions and trying to befriend someone 
for unsrupulous purposes. It is a punishable offence.

	 d)	 The various categories of cybercrime are:
	 	 •	 Crimes that target computer networks or devices, viz., virus and malware attacks.
	 	 •	 �Crimes that use computer networks to facilitate other criminal activities, viz., cyber 

stalking, fund transfers, identity theft, etc.
	 e)	� The infectious programs that may hamper the workings of a computer system are called 

malware. It is unwanted software created and designed by miscreants to damage a computer 
system. Examples of malware are virus, worm, trojan horse, spyware, etc.

	 f)	 �A computer virus (Vital Information Resources Under Seize) is a type of unwanted malicious 
software created by miscreants that infects or corrupts the files and hampers the functioning 
of a computer system. It does not evolve by itself, and is uploaded or injected through 
a network into storage media. It may also be transmitted from one computer to another 
by some medium like CD’s, pen drives, external HD, software, bluetooth, etc. It has the 
capability of replicating itself. Examples of some common viruses are Koobface, CiaDoor, 
Bro_AcT, Byte Bandit, Brain, etc.

	 g)	� A worm is a malicious computer program designed to slow down the functioning of a 
computer. It has the capability of replicating itself inside the host computer and thus 
occupy a lot of storage space. It mainly spreads through computers connected to a network. 
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Examples of worm are—Linux Ballpit, Bigen3, Morris worm, Mydoom, Sasser, etc.
	 h)	� It is a virus that silently infects a program of a host computer or steals information through 

a network. It is present in computer games and e-mails but it doesn’t replicate itself. It is 
active inside the computer when the user is busy interacting with entertaining programs like 
computer games. They are used by hackers as they can enter the database of a computer 
system under the guise of some entertaining package. It is also termed as ‘backdoor’. 
Examples of trojan horses are Linux Wifatch, Infostealer, Kronbank, etc.

	 i)	� Spam is an unwanted and unsolicited message that is received in the inbox of a person’s 
e-mail account or in newsgroups. Spams are sent with an intention to advertise products 
and services.

	 j)	� A program file virus is a type of malware that infects the executable files of a program with 
the intention of causing permanent damage or making the program useless. A file infecting 
virus inserts infected code into the source of an executable or program file.

VI.	 a)	 The various points which we should keep in mind while browsing the internet are:
	 	 •	 Install and use proper antivirus and antispyware software.
	 	 •	 Use Firewall to keep software and hardware secure.
	 	 •	 Use strong passwords.
	 	 •	 Update the security software at regular intervals.
	 	 •	 Don’t click on unknown links in e-mail or instant messages.
	 	 •	 Never install software from unknown sources.
	 	 •	 Clear browser cookies frequently.
	 	 •	 Avoid using unsecured Wi-Fi.
	 b)	 The following are a few points to keep in mind in order to create strong passwords:
	 	 •	 �Good password strength can be achieved by using different characters in it, i.e., don’t 

repeat the characters used in passwords.
	 	 •	 Avoid using the same password for multiple purposes.
	 	 •	 It must be hard to guess but easy to remember.
	 	 •	 �You must include at least eight characters. The more the numbers of characters the 

better will be the password.
	 	 •	 Avoid using the names of loved ones, relatives, friends, nick names, etc. in passwords.
	 	 •	 It should be a mixture of upper and lower case letters.
	 	 •	 It should have special symbols like—!, @, #, ? and numbers too.
	 c)	� Cyber security is the practise of guarding against digital attacks on systems, networks, and 

programmes. Some of the measures which can be practiced to ensure cyber security are:
	 	 •	 �Identity Protection: It refers to safety practices to prevent the theft of personal information 

such as personal profile details, bank account details, address details, and family details, 
and also to prevent unauthorised people from obtaining credit card benefits, ordered 
goods, passports, etc.
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	 	 •	 �Protect Username and Password: A user should never save the information in a computer 
that is used in a shared environment, such as internet cafes.

	 	 •	 �Do not share Personal Information: Be careful while filling out forms, or responding to 
calls that ask for your name, DOB, bank details, etc.

	 	 •	 �Secure Online Transactions: Use only secure websites for doing online transactions. A 
digital certificate represented by a golden lock in the web browser’s address bar signifies 
that the website is secure.

	 	 •	 �Avoid using Unsecured Wi-Fi: Never connect your device to any unsecured or unknown 
Wi-Fi network. Connecting to an unsecure network might lead to leakage of your valuable 
data.

	 d)	� There is certain information that we want to keep secret and keep its access limited either 
to ourselves, our family, or a circle of friends. It means keeping the data or information 
secret and allowing only authorized people to access the information.

	 	 The following data comes under this category:
	 	 •	 Medical history records
	 	 •	 Date of Birth
	 	 •	 Contact details
	 	 •	 Income status
	 	 •	 Photographs of family or friends
	 e)	� The various ways by which we can protect ourselves from Cyber Stalking are:
	 	 •	 �Keep evidence: The e-mail and other messages of the stalker should not be deleted. 

Keep printouts of the mails and messages.
	 	 •	 �Save all records: Keep a record of the written threats of the stalker. In case of verbal 

threats keep records of the date, time, and circumstances of those threats.
	 	 •	 �Contact the stalker’s ISP: The Internet Service Providers (ISP) can take action in case they 

get proper proof that any users has been using their service for harassing others. In such 
a case the ISP stops providing services to the user.

	 	 •	 Keep records: The records of complaints should be kept for future use.
	 f)	� The nodal national agency which works for the prevention of cybercrime is CERT-In 

(Indian Computer Emergency Response Team, Department of Electronic and Information 
Technology and Ministry of Communication and Information Technology). Its various 
functions are:

	 	 •	 It collects, analyses, and disseminates information on cyber incidents.
	 	 •	 �It forecasts and alerts the relevant authorities about probable incidents of cyber security 

breach.
	 	 •	 It provides emergency measures for handling cyber security incidents.
	 	 •	 �It  issues guidelines, advisories, and  vulnerability notes relating to information security 

practices, procedures, and prevention.
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	 g)	 The following violations can be reported to CERT-In:
	 	 •	 Attempts to gain unauthorized access to a system or data.
	 	 •	 �Making  changes  to  system  hardware,  firmware  or  software  characteristics  without  

the  owner’s consent.
	 	 •	 E-mail-related security issues, spamming, mail bombing, malware attack, etc.
	 h)	 The symptoms shown by a computer when attacked by a virus are:
	 	 •	 �Slowdown: A sudden change in the processing speed of a computer, as viruses have the 

tendency to slow down the processing abruptly.
	 	 •	 �Pop-ups: Unexpected pop-ups which appear on the system are a typical sign of a 

spyware infection. It usually comes in bundles with other malware which could be more 
destructive.

	 	 •	 �Crash: Viruses can damage the hard disk of a computer through means such as frequent 
crashing of system or BSOD (Blue Screen Of Death).

	 	 •	 �Running Out of Storage Space: A virus may install its copies or replicate unwanted files 
and occupy a huge amount of space.

	 	 •	 Loss of Files: Some viruses may delete file from a computer system.
	 	 •	 �Unusual activity of messages or programs: Some viruses may lead to automatic opening 

or closing of a program, restarting of a computer abruptly, and opening of strange 
windows during the process of booting.

	 	 •	 �Unusual Network Activity: When a computer system is infected, it may result in unusual 
network activity such as excessive transfer of data even when all the applications are 
closed or even losing connectivity in the network.

	 i)	� Spyware is a program which infects a computer and collects information from it without 
the owner’s consent. It generally infects a computer system through websites, e-mails, or 
through a network to which the computer is connected. To prevent the attack of spyware:

	 	 •	 Use anti-spyware software.
	 	 •	 Avoid exploring the error dialogs on the internet.
	 	 •	 Avoid using free deal offers on the internet.
	 	 •	 Verify the authenticity of a desired program before installing in on your computer.
VII.	 a)	 Morris worm, Mydoom	 b)	 Kronbank, Infostealer
	 c)	 Koobface, CiaDoor		  d)	 Michelangelo, AntiEXE
	 e)	 Avast, McAfee			   f)	 Windows, Linux
	 g)	 Ar@28Lc5, P75d@Xc8	 h)	 Virus, Worm
VIII.	a)	 The following are the steps to report an incident to CERT-In:
	 	 (i)		 Open any web browser and then visit the website: www.cert-in.org.in
	 	 (ii)		 Click on the ‘Incident Reporting’ link.
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	 	 (iii)	� Double click on the ‘Security Incident Reporting Form’ link and download the incident 
reporting form.

	 	 (iv)	� Fill the relevant details in the form and send it to CERT-In through- Email or Post or 
Fax. Through e-mail: incident@cert-in.org.in

	 		  Through Post- To,
	 			�	   Indian Computer Emergency Response Team (CERT-In), Ministry of Electronic 

and Information Technology, Government of India, Electronic Niketan, 6 CGO 
Complex, Lodhi Road, New Delhi-110003, India.

	 	 	 Through Fax- +91-11-24368546
	 b)	 The following are the steps to report a vulnerability incident to CERT- In:
	 	 (j)  	 Open any web browser and then visit the website: www.cert-in.org.in
	 	 (ii)		 Click on the ‘Vulnerability Reporting’ link.
	 	 (iii)	� Double click on the ‘Reporting of a vulnerability’ link and download the vulnerability 

reporting form.
	 	 (iv)	� Fill the relevant details in the form and send it to CERT-In through- Email or Post or 

Fax.
	 			   Through e-mail: vulnerability@cert-in.org.in 
	 			   Through Post- To,
	 				�    Indian Computer Emergency Response Team (CERT-In), Ministry of Electronic 

and Information Technology, Government of India, Electronic Niketan, 6 CGO 
Complex, Lodhi Road, New Delhi-110003, India.

	 	 Through Fax- +91-11-24368546
	IX.	 The accounts department must make sure that the website they are using for such a big 

transaction is secure. The website must have a digital certificate represented by a golden 
lock in the web browser’s address bar and the web address must start with ‘https’.

	X.	 Real-time protection is a security feature that stops malware from being installed on your 
device. With real-time protection the malware gets detected before it gets into the device. 
For real-time protection I would suggest installing updated ‘Antivirus’ and ‘Anti-spyware’ 
programs.

XI.	 a)	 Virus		 b)	 Anti-Virus	 c)	 Boot Sector Virus

	 d)	 Worm	 e)	 Trojan Horse	 f)	 Virus

	 g)	 Boot Sector Virus	 h)	 Worm	 i)	 Anti-Virus

	 j)	 Trojan Horse

XII.	 Do yourself.
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	Word Processor

I.	 a)	 .odt		  b)	 Clipboard	 c)	 Kerning	

	 d)	 Margin	 e)	 marks	 f)	 AutoSpellcheck	

	 g)	 Cell	 m	 h)	 merged	 i)	 splitting

II.	 a)	 (i)			  b)	 (i)	 c)	 (ii)

	 d)	 (i)			  e)	 (ii)	 f)	 (i)

III.	 a)	 Superscript Subscript
(i) � It is a formatting option that 

helps to display the characters or 
text above the standard baseline 
(placement) of the textual matter.

(ii) � Example- (a+b)2, Here 2 is the    
superscript

(i) � It is a formatting option that 
helps to display the characters or 
text below the standard baseline 
(placement) of the textual matter.

(ii) � Example- H2O, Here 2 is the 
subscript

	 b)	 Undo Redo
(i) � Undo command helps the user to 

reverse  a series of actions.
(ii)	 � Ctrl+Z is the shortcut key for 

Undo.

(i)	 � Redo helps to reverse the actions	
that have been executed by the 
Undo command.

(ii)	 � Ctrl+Y is the shortcut key for 
Redo.

IV.	 a)	 Superscript option	 b)	 Kerning

V.	 a)	� A word processor is a kind of software that provides a user-friendly page layout to type 
text and create documents. It also helps in editing, formatting, modifying, printing, and 
storing the contents  of  the document. Some important features of word processors are:

	 	 •	 �Editing: Any changes can be made easily without making the document messy. A user 
doesn’t need to retype the whole text while making alterations.

	 	 •	 �Interface: A word processor provides a layout which makes it convenient to type 
documents without using paper or stationery.

	 	 •	 �Navigation between pages: A user can easily switch between pages of a document 
instantly in a word processor to view or edit it.

	 	 •	 �Formatting: A user can change the look of the document by changing its font, colour, 
size, style, appearance, etc.

3.
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	 	 •	 �Graphics: In a word processor, graphical pictures, shapes, images, etc. can be inserted 
according to the need of the document.

	 	 •	 �Spelling and Grammar: A word processor has the provision of automatically checking 
spelling and grammar with suggestions to rectify them.

	 	 •	 �OLE: It is an object linking and embedding feature that helps to link or embed various 
objects in a document from another application.

	 	 •	 �Mail Merge: In a word processor, multiple copies of the same document can be sent to 
different recipients using the mail merge feature,.

	 	 •	 �AutoCorrect: It is feature of word processor that helps to change the mis-spelt words 
in the whole document automatically.

	 	 •	 �Find and Replace: It is feature of word processor that can search a word or a phrase in  
a document and can also replace a particular word or phrase with something else in the 
entire document.

	 b)	� A margin is the gap between the edge and beginning of text, i.e., the outer boundary of the 
text in a document beyond which the contents of the document do not flow. The default 
margins are 0.79" on the top and bottom and 0.79" on the left and right. The following are 
the different types of margins:

	 	 •	 Left margin: It is the space between the text and the left edge of the page.
	 	 •	 Right margin: It is the space between the text and the right edge of the page.
	 	 •	 Top margin: It is the space between the text and the top edge of the page.
	 	 •	 Bottom margin: It is the space between the text and the bottom edge of the page.
	 c)	� A Header and a Footer is the text that is displayed on top and bottom of every page of a 

document. It may display information such as- page number, date, logo of a company/
document owner, organization, title, filename, author, etc. It signifies the authenticity of 
the document and no-one can add or remove any page from it.

	 	 The following are the steps to apply Header in a document:
	 	 (i)		 Select ‘Header and Footer’ option from the ‘Insert’ menu.
	 	 (ii)		 Select the option ‘Default’ from the sub-menu and then ‘Header’ option.
	 	 (iii)	� A rectangular box appears at the top of the document. Type the required text that 

you want to display as header inside the box.
	 	 (iv)	� Click the mouse button outside the rectangular box. The required text gets applied 

as a Header to the document.
	 	 The following are the steps to apply Footer in a document:
	 	 (i)		 Select ‘Header and Footer’ option from ‘Insert’ menu.
	 	 (ii)		 Select the option ‘Default’ from the sub-menu and then the ‘Footer’ option.
	 	 (iii)	� A rectangular box appears at the bottom of the document. Type the required text  

that you want to display as footer inside the box.
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	 	 (iv)	� Click the mouse button outside the rectangular box. The required text gets  applied 
as a Footer to the document.

	 d)	 The following are the different types of line spacing options:
	 	 •	 Single: It provides a single line spacing.
	 	 •	 1.5 line: It provides one and a half line spacing.
	 	 •	 Double: It provides double line spacing.
	 	 •	 �Proportional: It lets a user enter spacing in percentage value. 100% is equivalent to a 

single line.
	 	 •	 Leading: It sets the vertical space that is inserted between two lines.
	 	 •	 Fixed: It sets the line spacing to match the exact value entered in the box.
	 e)	 The following are the steps to insert Date and Time:
	 	 (i)		 Place the cursor where the date is to be inserted.
	 	 (ii)		 Select ‘Field’ from the ‘Insert’ menu.
	 	 (iii)	 Click on ‘Date’ to insert the system date and click on ‘Time’ to insert the system time.
	 f)	� Combining two or more adjacent cells in the same row or column is known as merging of 

cells whereas division of cells into two or more cells is known as splitting of cells.
	 	 The following are the steps to merge cells:
	 	 (i)		 Select the adjacent cells to merge.
	 	 (ii)		 Select ‘Merge Cells’ option from the ‘Table’ menu.
	 	 (iii)	 Selected cells get merged.
	 	 The following are the steps to split cells:
	 	 (i)		 Select the cell to split.
	 	 (ii)		 Select ‘Split Cells’ option from the ‘Table’ menu.
	 	 (iii)	 ‘Split cells’ dialog box appears on the screen.
	 	 (iv)	� Select the number of columns and the number of rows into which the cell is to be split.
	 	 (v)		 Click on the ‘OK’ button. The selected cell gets split.
	 g)	 The following are the steps to add a mathematical expression in a document:
	 	 (i)		� Select ‘Object’ from the ‘Insert’ menu and choose the option ‘Formula’ from the sub-

menu.
	 	 (ii)		 Formula window appears on the screen.
	 	 (iii)	 ‘Element’ dialog box appears with several options. Select the desired expression.
	 	 (iv)	 The expression gets displayed on the document and the edit window.
	 	 (v)		 Write the expression as required and remove the right and left angular brackets.
	 	 (vi)	� Click anywhere on the document window. Close the Formula window. The formula 

get inserted in the document.
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	 h)	 The following are the steps to insert special characters in a document:
	 	 (i)		 Place the cursor where the special characters are to be inserted.
	 	 (ii)		 Select the ‘Special Characters’ option from the ‘Insert’ menu.
	 	 (iii)	 ‘Special Characters’ dialog box appears on the screen.
	 	 (iv)	 Click on the required character to insert.
	 	 (v)		 Click on the ‘OK’ button to insert the selected character.
VI.	 a)	� Format Paintbrush tool is used to synchronize the display of document by applying the 

same style of formatting.
	 b) 	� The types of alignment are: Left Alignment, Right Alignment, Center Alignment and Justified 

Alignment.
	 c)	 By default, header or footer is printed at 0.5” gap from the edge of the page.
	 d)	 The steps to insert symbol are:
	 	 (i) 		� Place the cursor where the symbol has to be inserted and select ‘Special Characters' 

option from ‘Insert’ menu. 
	 	 (ii) 	 Click on the required symbol from 'Special Characters' dialog box. 
	 	 (iii) 	 Click on 'OK' button to insert the symbol.

		 Spreadsheet

I.	 a)	 16,384	 b)	 Text Orientation	 c)	 Autofill
	 d)	 fx			   e)	 .ods

II.	 a)	 (i)			  b)	 (i)	 c)	 (i)

	 d)	 (ii)			  e)	 (i)

III.	 a)	
AutoFill Custom List

�AutoFill is a feature in spreadsheet 
in which a certain kind of predefined 
series of data such as the names of 
months of a year, serial numbers, etc. 
are automatically generated once the 
user feeds the initial data.

�	Custom List is a feature which is used 
to create a custom list where a series 
of names or text can be predefined 
and then displayed when the initial 
data is entered and AutoFill is applied.

4.
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	 b)	 Undo Redo
(i)	 � Undo command helps the user to 

reverse  a series of actions.

(ii)	 � Ctrl+Z is the shortcut key for 
Undo.

(i)	 � Redo helps to reverse the actions	
that have been executed by the 
Undo command.

(ii)	 � Ctrl+Y is the shortcut key for 
Redo.

	

	 c)	 Wrap text Shrink to fit cell
�It is a formatting option that wraps the 
text in multiple lines to accommodate 
the text within the column width by 
increasing the row height.

It automatically reduces the font size 
of the content to accommodate it 
within the column width.

	

IV.	 a)	� A spreadsheet package is an application software that does analysis, calculations, and 
comparisons and displays information in the form of a table, i.e., rows and columns. It 
helps a user to arrange and store data in a systematic manner. Some important features 
of a spreadsheet package are:

	 	 •	 In a spreadsheet, bulk volumes of data can be kept and handled in an easier way.
	 	 •	 In a spreadsheet, complex and long calculations can be solved quickly and accurately.
	 	 •	 Data can be expressed in tabular (rows and columns) or pictorial form.
	 	 •	 �The formula for doing calculations can be automatically applied to a set of data in 

different cells.
	 b)	 Steps to hide a worksheet:
	 	 (i)		 Select the sheet to be hidden.
	 	 (ii)		 Select the 'Sheet' option from the 'Format' menu.
	 	 (iii)	 Click on the 'Hide' option.
	 c)	 Steps to add a new sheet in a workbook:
	 	 (i)		� Right click on the 'Sheet' tab and select the 'Insert Sheet' option. 'Insert Sheet' dialog 

box appears.
	 	 (ii)		 Click on the 'OK' button. A new sheet will be added to the workbook.
	 d)	� AutoFill is a feature in Spreadsheet in which a predefined series of data such as names of 

months of a year, serial numbers, etc. is automatically generated once the user feeds the 
initial data. For example, To print series of months of the year:

	 	 •	 Type the initial data (month name) of the series in one cell.
	 	 •	 �Select the cell. An AutoFill handle appears at the bottom-right corner of the selected 

cell.
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	 	 •	 �Click on the AutoFill handle tool and drag it over the range of cells to fill the defined 
series, then release the mouse button. The series of months will be displayed.

	 e)	 Types of data that can be entered in the cells of a spreadsheet are:
	 	 •	 �Numeric Data: It consists of digits (0-9), exponential, decimal, and numeric operators 

like +, -, /, *, %, $. 
	 	 •	 �Alphanumeric or Text Data: It refers to the data which is a combination of alphabets, 

space, digits and special characters.
	 	 •	 Date and Time: It displays data in the form of date and time.
	 	 •	 �Formula: It is an expression which helps to perform arithmetical calculations and also 

executes non-arithmetical tasks.
	 f)	 The different alignment options available in a spreadsheet like ‘Calc’ are:
	 	 •	 Right alignment: It shifts the data in the cell to the right side of the cell.
	 	 •	 Left alignment: It shifts the data in the cell to the left side of the cell.
	 	 •	 Center alignment: It shifts the data to the center of the cell.
	 	 •	 �Filled alignment: It aligns the data within the column width only. The data which does 

not get accommodated in the cell width will be hidden in the sheet.
	 	 •	 �Justify: It shifts the data completely within the column width by increasing the column 

width.
V.	 a)	� Formula bar: Formula bar lies below the formatting toolbar. Formulas that perform different 

calculation�s in cells are entered and displayed here. It is denoted by 'fx'.
	 b)	� Operands: The values or variables on which the calculations are performed  are called 

operands.
	 (c)	� Sheet Tabs: They lie below the active sheet of the screen. The names of the worksheets 

appear in the sheet tabs at the bottom of the workbook.
	 d)	� Formatting Cells: It refers to changing the contents of a cell with respect to appearance, 

i.e., changing the text, styles, alignment, font size, font style, border, patterns, etc.
VI.	 a)	 Rohit can make the text appear properly by using the 'shrink to fit cell size' option.
	 b)	 AutoSum	
	 c)	 E9
	 d)	 An application software like Spreadsheet could be used by the company.
	 e)	 AutoFill
	 f)	 Custom List



Touchpad CA-165-IX (Answer Key)18

		 Data Analysis

I.	 a)	 Cell Reference	 b)	 Absolute	 c)	 Chart

	 d)	 Sorting	 e)	 #REF!

II.	 a)	 (i)			  b)	 (iii)	 c)	 (i)	

	 d)	 (i)			  e)	 (ii)

III.	 a)	 Relative Referencing Mixed Referencing
(i) � It is based on the position of the 

cell in which the formula is typed 
with respect to the cell address of 
the formula.

(i) � This type of cell referencing is 
the combination of absolute and 
relative referencing.

(ii) � When we copy or move the formula 
to other cells, the reference (cell 
address) automatically changes 
according to the relative position 
of the cells in consideration.

(ii) � While applying mixed referencing, 
either the row number or the 
column name of the cell address 
in the formula is fixed.

	 b)	 Sorting Filtering
�Sorting refers to the process of 
arranging data in ascending or 
descending order based on a certain 
criteria.

�Filtering is a quick and easy way to 
get the required information from a 
subset of data in a range of cells.

	 c)	 Column Chart Bar Chart
(i) � A column chart represents the data 

over a period of time in columns.
(i) � A bar chart represents the data in 

horizontal columns.

(ii) � Each column rises from the X-axis 
and indicates the value of a piece 
of data.

(ii) � The measurement of values is 
organised horizontally.

5.
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	 d)	 Pie Chart Area Chart
(i) � A pie chart represents the data or 

value of each item in proportion 
or percentage to the consolidated 
or sum value of all items.

(i) � An area chart is a version of a line 
or column graph.

(ii) � A pie chart displays a single type 
of data item and is beneficial when 
the user wants to emphasize the 
value of a significant item.

(ii) � It is useful to emphasize the  
volume of change in the data.

IV.	 a)	� Formulas are applied to perform mathematical operations such as addition, subtraction, 
multiplication, division, etc. on large volumes of data in a worksheet.

	 	 Different types of formulae used in ‘Calc’ are:
	 	 •	 �Formula with Cell Address: Each cell in the worksheet has a unique address that is formed 

by the intersection of its Column and Row.
	 	 •	 �Formula with Cell Names: In ‘Calc’, a formula can be applied in reference to cell names. 

For doing so, first define the name of the cell or the range of cells.
	 	 •	 �Formula with In-Built Functions: Functions are in-built in some formulae in ‘Calc’, which 

can be used to perform arithmetical and non-arithmetical tasks.
	 b)	� There are three types of referencing in ‘Calc’:
	 	 Cell referencing helps in locating a specific value and creating formulas in Calc.
	 	 •	 �Relative Referencing: It is based on the position of the cell in which the formula is typed 

with respect to the cell address of the formula.
	 	 •	 �Absolute Referencing: It is applied when a user does not want to change the value while 

copying the formula with cell address to another cell.
	 	 •	 �Mixed Referencing: This type of cell referencing is the combination of absolute and 

relative referencing. While applying mixed referencing, either the row number or the 
column name of the cell address in the formula is fixed.

	 c)	� Functions are in-built formula in ‘Calc’, which can be used to perform arithmetical and 
non-arithmetical tasks. 

	 	 The different parts of function are ‘Name’ & ‘Argument’. 
	 	� ‘Name’ is the function that signifies the nature of operation. ‘Argument’ specifies the values 

or the range of cells on which the specific operation is being applied and is always enclosed 
within the opening and closing parenthesis.

	 	 •	 For example: =sum(A1:A5)
	 	 •	 Sum is name of the function.
	 	 • 	 A1:A15 is the argument of the function.
	 d)	� Sometimes when we use the wrong type of data, operand or operator in a formula, then 

an error message is displayed. The list of errors which commonly occurs in ‘Calc’ are:
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	 	 •	 �####: Occurs when the cell contains a number, data, or time that is wider than the cell 
width or when the cell contains a date and/or time formula that produces a negative 
result.

	 	 •	 #VALUE: Occurs when the wrong type of argument or operand is used.
	 	 •	 #NAME: Occurs when ‘Calc’ does not recognize text in a formula.
	 	 •	 #NUM: Occurs when there is a problem with a number in a formula or function.
	 	 •	 �#REF!: Occurs when a cell reference is not valid. #DIV/O! Occurs when a formula is divided 

by zero.
	 	 •	 #DIV/0!: Occurs when a formula is divided by zero.
	 e)	� A chart is a visual graphical representation of data from a worksheet. It is very useful for 

instant analysis of data and decision-making. Four types of charts:
	 	 •	 �Line Chart: It is used to view information that is shown by lines at equal intervals. It 

depicts the change in data over a period of time.
	 	 •	 �Bar Chart: A bar chart represents the data in horizontal columns. The measurement of 

values is organized horizontally.
	 	 •	 �Area chart: An area chart is a version of a line or column graph. It is useful to emphasize 

the volume of change in data.
	 	 •	 �Pie Chart: A pie chart represents the data or value of each item in proportion or 

percentage to the consolidated or sum value of all items.
V.	 a)	 Akash should use a spreadsheet like Calc or Excel for this purpose.
	 b)	 The formula will become =B3+C3
	 c)	 The cell address will be I10.
	 d)	 Absolute referencing
	 e)	 (i)		  In cell C1, 44 will be displayed
	 	 (ii)		  In cell E1, -40 will be displayed.
	 	 (iii)	 	 Formula in cell E3 will be =$B$3+D3
	 f)	� This error occurs when the cell contains a number, data, or time that is wider than the cell 

width or when the cell contains a date and/or time formula that produces a negative result.
	 g)	 In cell B8, the formula used is =AVERAGE(B2:B7)
	 h)	 A bar chart is shown in the figure.
VI.	 a)	 Steps to insert a new record are:
	 	 (i)		 Type the values 3, Shyam, 56, 76, 89, 23, 27, 29, 22, 21, 20, 22
	 			   Same way enter the values for more four records.
	 b)	� Type the formula =sum(F4:H4) in N4 to calculate total marks scored in science. Type the 

formula =sum(I4:L4) in M4 to calculate total marks scored in social studies.
	 c)	 Steps to copy the formulas of cell N4 are:
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	 	 (i)		 Click on the cell N4.
	 	 (ii)		� Drag down the 'AutoFill Tool' of the cell over the new cells where formula has to be 

applied.
	 	 Steps to copy the formulas of cell M4 are:
	 	 (i) 		 Click on the cell M4.
	 	 (ii) 	� Drag down the 'AutoFill Tool' of the cell over the new cells where formula has to be 

applied.
	 d)	 Steps to calculate the percentage are:
	 	 (i) 		 Type the formula =sum(C4:L4)/5 in O4.
	 	 (ii) 	� Drag down the 'AutoFill Tool' of the cell over the new cells where formula has to be 

applied.
	 e)	 Steps to calculate maximum marks obtained are: 
	 	 (i) 		 Type the formula =max(C4:C10) 
	 	 (ii) 	� Drag right side the 'AutoFill Tool' of the cell over the new cells where maximum marks 

are to be obtained.
	 	 Steps to calculate minimum marks obtained are: 
	 	 (i)		 Type the formula =min(C4:C10) 
	 	 (ii) 	� Drag right side the 'AutoFill Tool' of the cell over the new cells where minimum marks 

are to be obtained.

		 Presentation

I.	 a)	 Watermark	 b)	 Slide layout	 c)	 Slide show

II.	 a)	 (i)			  b)	 (ii)

	 c)	 (iv)		  d)	 (i)

III.	 a)	� A presentation package is a software program which is used to display information in the 
form of a slideshow. It includes text, pictures, figures, charts, audio, video and animated 
objects which are organized in a proper sequence. Some of the features of 'Impress' are:

	 	 •	 �In Impress, online screen presentations, web presentations, printouts, notes, handouts 
and outlines can be made easily.

	 	 •	 �In Impress, there are added facilities like design templates, pictures, etc., that help to 
create the slides easily and effectively.

6.
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	 	 •	 �The slides in Impress can contain texts, graphs, tables, graphics, photographs, sounds 
and even music.

	 b)	 A user has the following three options to design a presentation:
	 	 •	 Empty Presentation
	 	 •	 From Template
	 	 •	 Open existing presentation
	 c)	 The different views to display a presentation through Impress are:
	 	 •	 �Normal view: In normal view (by default) a blank slide appears on the workspace. It 

enables a user to make a presentation as per the requirements.
	 	 •	 �Outline View: Outline View displays the slides of a presentation in the miniature format, 

which is without background, colour, graphics, etc.
	 	 •	 �Notes View: In the notes view, the slides are displayed in a reduced form on top of the 

page.
	 	 •	 �Handout View: The handout view enables a user to prepare a hard copy or summary 

of the presentation.
	 	 •	 �Slide Sorter View: In Slide Sorter View, the user can view all the slides in a small size on 

the screen.
	 	 •	 �Slide Show: The ‘Slide Show’ view is used to view the complete presentation in full 

screen view, with each slide being displayed one by one.
	 d)	� Slide layouts refer to the basic look or the frame of slides to which contents can be added. 

In Impress, there are various types of predefined layouts for creating slides which can be 
used for creating a new presentation. Steps to insert a layout in presentation are:

	 	 •	 Right click on any of the slides from the sidebar deck.
	 	 •	 Click on the 'Slide Layout' option. It will display the slide layout window.
	 	 •	 �Select the desired layout. The layout of the slide appears on the workspace as a frame 

for slide.
IV.	 a)	 To add a new text box in a presentation:
	 	 •	 �Select the 'Text Tool' button from 'Drawing' tool bar. The mouse pointer changes to (+) 

sign.
	 	 •	 Place the cursor to the position on the slide where the 'Text Box' is to be added.
	 	 •	 Drag the pointer to create the text box.
	 b)	 To insert header and footer in a presentation:
	 	 •	 �Click on the 'View' menu and select the 'Header and Footer' option. The Header and 

Footer dialog box appears.
	 	 •	 �In the 'Slide' tab of dialog box, 'Check' the Footer checkbox. Type the desired text for 

footer and click on either 'Apply to All' or 'Apply'.
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	 	 •	 �To change or add the Header information, click on the 'Notes and Handouts' tab in the 
'Header and footer' dialog box.

	 	 •	 �Check the header checkbox. Type the desired text for footer and click on either 'Apply 
to All' or 'Apply'.

	 c)	 To delete a slide in a presentation:
	 	 •	 Right click on the slide which is to be deleted. A list opens with various options.
	 	 •	 Click on 'Delete Slide' from that list. The selected slide gets deleted.
	 d)	 To insert slide numbers in a presentation:
 	 	 •	 Click on the 'Insert' menu and click on the 'Page Number' option.
	 	 •	 'Header and Footer' dialog box appears. Click on the 'Slide number' checkbox.
	 	 •	 Click on 'Apply' to insert a page number to the selected slide.
	 	 •	 �To insert slide numbers to all the slides of the presentation, click on the 'Apply to All' 

button.
V.	 a)	 Template	
	 b)	� The slide show view is used to view the complete presentation and it displays each slide in 

full screen mode one by one. On the other hand, the slide sorter view is used to view more 
than one slide in a smaller size on the screen.

	 c)	 Slide Show
	 d)	 To do so:
	 	 •	 Select the text box.
	 	 •	 Choose the desired colour from the 'Color Bar' (located at the bottom of the screen).
	 e)	 i)	 To do so:
	 	 	 •  Insert the graphic (picture, chart, etc.) in the slide which has to be used as watermark.
	 	 	 •	 Click on 'Color mode' from the Graphic sidebar deck and select 'Watermark'.
	 	 ii)	 To do so:
	 	 	 •	 �Click on the 'View' menu and select the 'Header and Footer' option. The Header and 

Footer dialogue box appears.
	 	 	 •	 �To change or add the Header information, click on the 'Notes and Handouts' tab in 

the 'Header and Footer' dialogue box.
	 	 	 •	 �Check the Header checkbox. Type the desired text for Footer and click on either 

'Apply to All' or 'Apply'.
		  iii)	 To do so:
	 	 	 •	 Click on the 'Insert' menu and click on the 'Page Number' option.
	 	 	 •	 The 'Header and Footer' dialogue box appears. Click on the 'Slide number' checkbox.
	 	 	 •	 Click on 'Apply' to a insert page number to the selected slide.
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	 	 	 •	 �To insert slide number to all the slides of the presentation, click on the 'Apply to All' 
button.

VI.	 a)	 Title slide	 b)	 Click to add title.	

		 Effects in Presentation

I.	 a)	 organised, interesting	 b)	 Charts	 c)	 Ctrl, P
II.	 a)	� Handouts are thumbnails of all the slides printed together. These are the paper copies of 

your PowerPoint Presentation that you give to the audience.
	 b)	� During the presentation, a set of notes is required as  reference to help the demonstrator. 

Such notes are known as Speaker’s Notes. It is a small hint about the information present 
in a slide.

	 c)	 Four types of charts:
	 	 •	 �Line Chart: It is used to view information that is shown by lines at equal intervals. It 

depicts the change in data over a period of time.
	 	 •	 �Bar Chart: A bar chart represents data in horizontal columns. The measurement of values 

is organized horizontally.
	 	 •	 �Area chart: An area chart is a version of a line or column graph. It is useful to emphasize 

the volume of change in data.
	 	 •	 �Pie Chart: A pie chart represents the data or value of each item in proportion or 

percentage to the consolidated or sum value of all the items.
	 d)	 Two ways to set the timing of a slide show are:
	 	 •	 �Setting the time manually: Select the slide for which the timing has to be set and then 

click on the Transition option from the slide show menu.
	 	 •	 �Rehearse Timings: This option records and fixes the duration of time of display of each 

slide and the switch to the next slide during the presentation.
	 e)	� Custom animation is a set of effects which can be applied to objects in a presentation so 

that they will be animated in the slide show. It also enables a user to set timings for the 
display of the content or objects of the slides and to apply different whirling effects to 
animate the objects.

	 f)	� Slide transition is the effect applied when a slide changes to another during an on-screen 
presentation or a slide show. It enables a user to set the style of display of the slides during 
a presentation.

III.	 a)	 (ii)	 b)	 (iii)	 c)	 (iv)	 d)	 (ii)

7.
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IV.	 a)	 Grouping Un-grouping
�Different pictures and objects can be 
combined together to be displayed 
as a single object. The process of 
combining objects/pictures is known 
as grouping.

�Ungrouping objects means organizing 
the data in different forms like movies 
in different and pictures in different.

	 b)	 Custom Animation Slide Transition
(i) � Custom animation is a set of 

effects which can be applied to 
objects in a presentation so that 
they will appear animated in a 
slide show.

(i) � Slide transition is the effect applied 
when a slide changes to another 
during an on-screen presentation 
or a slide show.

(ii) � It enables a user to set timings 
between the display of the content 
or objects of the slides and to 
apply different whirling effects to 
animate the objects.

(ii) � It enables a user to set the style of 
display of the slides during their 
entry in a  presentation.

	

V.	 a)	� Rehearse Timing: This option records and fixes the duration of display of each slide and 
it switching to next slide while rehearsing or practicing for the presentation.  Rehearse 
Timings will begin the slide show in the rehearsal mode.

	 b)	� Animation: Animations are visual effects for objects in a PowerPoint presentation. It 
facilitates the display of contents in a special sequence of typical effects leading to an 
interesting and lively presentation. It includes multiple types of media control like graphics, 
video, sound, music, movies, etc.

VI.	 a)	 (i)		 Select the slide for which the transition is desired.

		  (ii)	 Select the slide transition option from 'Slide Show' menu.

		  (iii)	 Click on any of the transition effect.

		  (iv)	 Set the speed of display (slow, medium, fast) and the sound effect.

		  (v)	� Repeat the above steps to apply such effects in other slides, or apply the same transition 
effect to all the slides in the presentation, by clicking on ‘Apply to All Slides’.

	 b)	 (i)	 Click on the Slide Show menu.

		  (ii)	 Select the rehearse timing option.	

	 c)	 (i)	 Select the text/object which is to be animated.

		  (ii)	 Click on 'Custom Animation' option.

		  (iii)	� To apply animation to the content (text or object) when it enters the slide, click on 
the Entrance tab and then select any type of effect.
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		  (iv)	� To apply animation to the content that is being displayed, click on the ‘Emphasis’ tab, 
then select the type of effect.

		  (v)	� To apply animation to content that is to disappear from the slide, click on the ‘Exit’ 
tab and then select an effect.

		  vi)	� To apply animation which will move an object in a specified pattern, click on the 
‘Motion paths’ and then select an effect .

		  (vii)	 Click on OK to apply all the changes.

	 d)	 (i)	 Select the option ‘Pictures’ from the insert menu.

		  (ii)	 Click on  the file button.

		  (iii)	 Locate the picture.

		  (iv)	 To view the picture before inserting, click on ‘Preview’.

		  (v)	 Click on ‘Open’ to insert the picture.

	 e)	 (i)	� Select a style of effect, such as Entrance, Emphasis, Exit or Motion Paths from the 
tabs at the top of the dialog box. Choosing one of these styles will reveal a different 
selection of animation effects.

		  (ii)	� Make sure the Automatic preview box is checked to preview the animation on the 
slide.

		  (iii)	 Click on different animations and you will see a preview of the effect on your slide.

		  (iv)	 Make your selection.

		  (v)	 Choose an animation speed from the drop-down list.

		  (vi)	 Click OK.

VII.	 a)	 (i)	 To insert picture

		  (ii)	 To add movie or sound into the presentation

		  (iii)	 Slide Transition

		  (iv)	 Insert page number

	 b)	 (i)	 Highlighter

		  (ii)	 Download from the internet and save it.

		  (iii)	 Apply to All.

		 Scratch

I.	 a)	 (iv)	 b)	 (iv)	 c)	 (ii)
II.	 a)	 480, 360	 b)	 full	 c)	 Sprite
III.	     Column A		          Column B
	 a) 			   (c)	 Eyedropper tool

	 b) 			   (d)	 Stamp tool

	 c) 			   (a)	 Text tool

	 d) 			   (e)	 Fill tool

	 e) 	  		  (b)	 Select tool

IV.	 a)	� Animation is the display of sequence of images in order to create extraordinary illusions. It 
includes computer generated imagery (CGI) and multimedia features. This results in creation 
of more convincing illusions.

	 b)	� Sprite is a small graphic object that moves on the stage. The sprite moves, plays music, and 
executes other functions as per our instructions.

	 c)	� Script area contains the script which is the collection of graphics/blocks that are assembled 
in a particular order which get executed from the top to the bottom.

		 Animation in Scratch

I.	 a)	 Pen			   b)	 Motion

	 c)	 when green flag is clicked	 d)	 Stop

II.	 a)	 (i)	 b)	 (ii)	 c)	 (i)	 d)	 (iii)

III.	 a)	 Two programming blocks to be used are Move 50 steps and turn 25 degrees clockwise.

8.

9.
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		 Scratch

I.	 a)	 (iv)	 b)	 (iv)	 c)	 (ii)
II.	 a)	 480, 360	 b)	 full	 c)	 Sprite
III.	     Column A		          Column B
	 a) 			   (c)	 Eyedropper tool

	 b) 			   (d)	 Stamp tool

	 c) 			   (a)	 Text tool

	 d) 			   (e)	 Fill tool

	 e) 	  		  (b)	 Select tool

IV.	 a)	� Animation is the display of sequence of images in order to create extraordinary illusions. It 
includes computer generated imagery (CGI) and multimedia features. This results in creation 
of more convincing illusions.

	 b)	� Sprite is a small graphic object that moves on the stage. The sprite moves, plays music, and 
executes other functions as per our instructions.

	 c)	� Script area contains the script which is the collection of graphics/blocks that are assembled 
in a particular order which get executed from the top to the bottom.

		 Animation in Scratch

I.	 a)	 Pen			   b)	 Motion

	 c)	 when green flag is clicked	 d)	 Stop

II.	 a)	 (i)	 b)	 (ii)	 c)	 (i)	 d)	 (iii)

III.	 a)	 Two programming blocks to be used are Move 50 steps and turn 25 degrees clockwise.

8.

9.



Touchpad CA-165-IX (Answer Key)28

	 b)	� Programming blocks to be used are Move -90 steps, Turn 35 degrees anticlockwise and 
Repeat block.

	 c)	 Sensing block can be used by Kanta to perform her task.

	 d)	� Conditional blocks are if-else blocks. If the value of condition is 'true', then it will execute 
the blocks that are snapped within, otherwise it will execute the blocks that are outside the 
conditional block.

	 	 The Loop blocks are used to repeat an action.

	 e)	� Sensing button contains the programming blocks that enable to read the instructions given 
from input devices.

when clicked

forever

if thenkey Pressed?

say for secs

a

Hello! Who are You? 2

	 f)	� The ‘Looks’  button contains the programming blocks that control the look of a sprite and 
display graphical effects.

when clicked

forever

say

change

for

effected by

Hello!

color 25

secs2
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		 Python

I.	 a)	 IDLE (GUI)	 b)	 python shell	 c)	 Python shell window

	 d)	 underscore(_)	 e)	 Lexical Elements	 f)	 String literal

	 g)	 Print		  h)	 lower	 i)	 Reserve words

II.	 a)	 (i)	 b)	 (ii)	 c)	 (i)	 d)	 (ii)

	 e)	 (iv)	 f)	 (iv)	 g)	 (i)

III.	 a)	 General Public License

	 b)	 Centrum Wiskunde & Informatica

	 c)	 Integrated Development and Learning Environment

	 d) 	 Microsoft Installer

IV.	 a)	 Keyword: These are the reserved words that have specific functions in a program.
	 b)	 Token: The smallest individual unit in a program is called a token.
	 c)	 Punctuators: These are used as marks or separators in a program.
	 d)	 Variable: This is the data or value which can change during the execution of a program.
	 e)	 Expression: Operators when applied on operands form an expression.
	 f)	� Operator: This is the token that does computation or calculation with designated or given 

values in an expression.
	 g)	 Python Shell: It is the layout screen where we type a Python command.
V.	 a)	 The features of Python are:
	 	 •	 The keywords of Python are in simple English.
	 	 •	 �It is known as a platform independent programming language, i.e., it is portable and 

compatible with all types of operating systems.
	 	 •	 It is an interpreted language.
	 	 •	 It can be easily integrated with C, C++, Java, etc.
	 b)	� Data types are the kind of data to be stored in the variables which are being used while 

writing a program.
	 	 The different data types in Python are:
	 	 •	 Numbers	 •	 String	 •	 List
	 	 •	 Tuple	 •	 Dictionary

10.
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	 c) 	 �For single line comments, the comment line always starts with the symbol # whereas for 
multiple line comments, the comment should be enclosed within a pair of triple apostrophes.

	 d)	� The character set in Python consists of valid characters such as alphabets, digits or special 
characters that are recognized by the library of python language.

	 e)	 Guidelines for creating identifiers in Python are:
	 	 •	 �An identifier is an arbitrary sequence of letters in lower case (a-z) and upper case (A-Z), 

digits (0-9), and underscore (_).
	 	 •	 The first character of the identifier must be a letter or an underscore.
	 	 •	 An identifier must not be a keyword.
	 	 •	 An identifier must not contain any special character except underscore.
	 f)	� The interactive mode allows us to type a set of commands only in a line at the command 

prompt ‘>>>’. In script mode, we type the set of codes in more than one line in a file and 
then use the interpreter to execute the complete program from it.

	 g)	� The only drawback of interactive mode in Python is that we cannot save the statements for 
further use and we have to retype all the statements to re-run them.

	 h)	� Instructions that a Python interpreter can execute are called statements. Example, a=1 is 
an assignment statement.

	 i)	 A few applications of Python are:
	 	 •	 Web development
	 	 •	 Game development
	 	 •	 Software development
	 	 •	 Artificial intelligence and machine learning
	 	 •	 Business applications
	 	 •	 Education programs and training courses
	 	 •	 Language development
VI.	 a)	 #Program to print three numbers whose values are 10, 12, and 15. 
	 	 num1 = 10;
	 	 num2 = 12;
	 	 num3 = 15;
	 	 sum = num1+num2+num3; print(sum);
	 b)	 “’Program to display Your School Name’" 
	 	 print('ABC Model School’);




